
Scaling at the computer
– System Rensch –

User manual

v3.0 Mac

M!



© 1997-2015 Pleasant Software, Eberhard Rensch, Offenburg/Germany
 All rights reserved

Pleasant Software, Eberhard Rensch, Offenburg/Germany

This manual, the software described in it, the product design, and design 
concepts are copyrighted by Pleasant Software with all rights reserved. 
Neither the programs nor the manual may be copied, reproduced, trans- 
lated, transmitted or reduced to any printed or electronic medium or to 
any machine readable form, in whole or in part, without the written con-
sent of Pleasant Software.

Pleasant Software makes no warranties, either express or implied, re- 
garding the enclosed computer software package, its merchantability, or 
its fitness for any particular purpose. The exlusion of implied warranties 
is not permitted by some states. the above exclusion may not apply to 
you. This warranty provides you with specific legal rights. There may be 
other rights that you may have wich vary from state to state.

Pleasant Software grant no guarantee for the correctness of the contents 
in this manual.

Der Name Apple, das Apple Symbol und Macintosh sind Warenzeichen von Apple, Inc.

http://www.pleasantsoftware.com

M! mensura (lat.)	 scale, size, length
metior (lat.)	 to scale



3Inhalt

Inhaltsverzeichnis
7	 Preface

9	 First launch
Installation of M!............................................................9
Entering license data....................................................10
Launching M!................................................................10

11	 Chapter 1
The main window..........................................................11
Rename stops...............................................................12
The »Normal Scale« NM...............................................13
Changing the type of values in a column......................13
Duplicating columns.....................................................14
Moving columns............................................................15
Change a column’s width.............................................15
Decimal places..............................................................15
Filter displayed half tones.............................................15
Saving a document.......................................................16
Renaming a document..................................................16
Duplicating a document................................................16

17	 Chapter 2
Opening documents.....................................................17
Moving a scale..............................................................17
Position panel...............................................................18
Grid...............................................................................18
Modifying scale curves.................................................19
Bézier curves................................................................19
Free-hand mode...........................................................23

25	 Chapter 3
Columns and value parameters in the spreadsheet.....25
Cut-Up..........................................................................27
Thickness of Material....................................................28
Free Columns................................................................28
Entering Formulas.........................................................29
Links in Formulas..........................................................29



4 Inhalt

Fill Up/Down.................................................................30
Fixing Links...................................................................30
Example: Cut list...........................................................30

33	 Chapter 4
Creating a new stop......................................................33
Stop preferences..........................................................33
Name, Graphics & Compass........................................34
Foot tone level..............................................................34
Covered Stops..............................................................35
Mouth Scales................................................................36
2’, c13 = 25mm Ø, following NM..................................36
Refer Graphical Representation to NM.........................38
Other constant progressions........................................39
Deleting columns in the spreadsheet...........................41
Stop visibility.................................................................41
Broken scales...............................................................42
Fixed-variable scales....................................................43
Standard scale..............................................................44

47	 Chapter 5
Constant ratios.............................................................47
Free-variable mouth scales...........................................47
Duplicating scales.........................................................49
Linking mouth scales to Ø scales.................................50
Automatic scale for mouth width for numeric documentation	
52
Comments in the graphic view.....................................54
Linking comments.........................................................55
Grouping scales............................................................56
Using arithmetic operations and macros......................57

61	 Chapter 6
Non-cylindrical pipes with constant ratio.....................61
Displaying end Øs in the spreadsheet..........................61
Non-cylindrical pipes with free-variable ratio...............61
Free placement of names.............................................64

65	 Chapter 7
Entering a Ø scale in the spreadsheet..........................65
Hiding half tones...........................................................65



5Inhalt

Entering numerical values for mouth scale...................67
Entering numerical values for upper Ø.........................68
Registering Wooden Stops...........................................70
Error / Bad value...........................................................71
Locking columns...........................................................72

73	 Chapter 8
Printing..........................................................................73
Clipboard......................................................................73
Export orientation.........................................................74
Export as CSV...............................................................74
Export as DXF...............................................................75
Import...........................................................................76
Drag & Drop..................................................................77
Data exchange with other operating systems..............77

79	 Chapter 9
Application preferences................................................79
Document preferences.................................................81

85	 Index



6 ﻿



7Preface

Preface
The purpose of this manual is to present you 
with a tutorial for M!

In each chapter allied functions are explained 
with practical examples. 

It is highly recommended that the manual be 
worked through step by step at the computer. 
At the end of the manual you’ll find an index 
with which questions or problems you might 
run into can be quickly solved.

Welcome to M!
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First launch
Installation of M!In order to use M!, please follow these instal-

lation instructions:

1.	 Download the most recent version of M! here:  
http://www.pleasantsoftware.com/mensuren

2.	 If not mounted automatically, double click the  
downloaded disk image file (.dmg).

3.	 Follow the displayed instructions to copy M! 
to your applications directory.

4.	 Eject the disk image in Finder and launch M! 
from the applications directory.

If you want to add M! to the Dock, drag the 
program icon from the applications directory 
(not the disk image) to the dock. M! should 
appear in your Launchpad automatically, 
shortly after copying M! to the applications 
directory.

The downloadable demo version of M!  match-
es exactly the full version of the program. The 
only difference is, that without entering a val-
id license code, the full functionality is time 
limited.

Installation of M! • Entering license 
data  • Launching M!

http://www.pleasantsoftware.com/mensuren/de 


10 First launch

Here’s how to enter your license data:

After launching M!, open the preferences window 
by choosing the Preferences command from the 
M! menu. Switch to the License tab and enter your 
license data exactly as received in your license in-
formation.

Please note, that M! checks both,  the license 
name and the license code. Thus, it’s recom-
mended to enter the data via copy & paste 
whenever possible.

Launching M! Launch M! by double-clicking on the application’s 
icon in the Finder.

After launching, M! automatically shows a 
new document window:

Entering license data
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After M! has completed launching, a new 
scaling document named Untitled is opened.

The main window has three sections:

On the left side, the Stop list is displayed. This 
view lists the names of all stops (and groups) 
in the document.

In the middle, the Spreadsheet is displayed. 
When adding a stop to the document, M! au-
tomatically adds a column to this spreadsheet 
view, displaying the diameters of the new 
stop. It’s easy to add additional columns for 
each stop (displaying other scale types) or 
even so called »free« columns you can use to 
enter comments and simple formulas. 

On the right side, the Graphic view is dis-
played. The scales of all stops are displayed 
graphically in this view, as deviation from of 
the documents Normal Scale (NM).

All three views are continuously connected 
to each other. For instance, changing values 
in the spreadsheet will instantly update the 
graphic view representation of the respective 
stop. And if you move a line or anchor point in 
the graphic view, the values in the spreadsheet 
will change with it.

You can move the dividing lines between the 
three views to re-arrange the window. Click-

Chapter 1The main window • Renaming stops • 
Using the spreadsheet • Saving a doc-
ument

The main window
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ing on the List icon in tool bar in the upper 
left will toggle the visibility of the stop list off 
and on.

The visibility of the number and graphic views 
can be controlled with the segmented switch 
in the upper right: When the left segment is 
switched on, only the spreadsheet is visible. 
When switched to the right segment, only the 
graphic view is visible. To display both views 
side-by-side, switch to the middle segment 
(which is the default).

Toggling the visibility of the stop list as well 
switching the visibility of the number and 
graphics view is also possible by choosing 
one of the menu commands in the View menu. 
These menu commands are also associated 
with key board shortcuts (⌘⌥0, ⌘⌥1, ⌘⌥2 
and ⌘⌥3).

Please note, that document windows in M! 
support Mac OS X’s full screen mode. Click 
on the green maximize button in a window’s 
title bar to switch the window to full screen 
mode. Move the mouse pointer to the upper 
edge of the screen to show the menu bar and 
the window’s title bar. Click on the green but-
ton again to leave the full screen mode.

When moving divider lines 
between views, they will hit 
a limit eventually, when one 
of the affected views reach-
es its minimal width. If you 
continue to move the divider 
line after reaching this limit, 
the respective view will col-
lapse. To make a collapsed 
view visible again, use the 
respective button/switch in 
the tool bar or the respective 
menu command in the View 
menu.

If you want to maximize 
the size of a window with-
out switching to full screen 
mode, hold down the  ⌥-key 
while clicking on the green 
maximize button in the win-
dow’s title bar.

Rename stops To change the name of a stop, select the stop 
in the stop list by clicking on its name. Then 
click on the selected name again to edit. After 
editing the name, hit the return key (↩) or se-
lect another stop in the stop list.
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The »Normal Scale« 
NM

The Document Preferences 
dialog allows you to set oth-
er progressions as NM basis 
(see »Document preferenc-
es« at page 81).

Until now, the scale Principal 8‘ is only a 
straight horizontal line laying exactly at Nor-
mal Scale (NM). M! normally uses the Töpfer 
Normal Scale NM (octave ratio Ø = 1:∜8 or 
halving at the 17th) as a basis. All scales are 
shown a deviations from NM in ± n HT. For 
this reason, Principal 8‘ shows exactly this 
NM.

The new document contains a default stop Untitled. 
Rename this stop to Principal 8’.

The numerical values of this (or any other) 
scale are displayed in the spreadsheet, next to 
the stop list. For the moment, there is only one 
column showing the diameter in mm of each 
note. The name of the scale appears in the title 
bar of the spreadsheet along with the type of 
values shown. In this case Principal 8‘ and Ø 
[mm]. The data in the brackets designates the 
measuring unit presently in use.

Changing the type of 
values in a column

This menu will be referenced 
as »Column menu« in the 
future.

In order to change the data parameter(s) of a 
column, move the pointer onto the designa-
tion (Ø [mm]) of the column. When the point-
er changes to a menu icon, you can open a 
menu by pressing the mouse button. At the 
top of the menu you can choose the desired 
parameter.

Choose Circumference [mm] from the column 
menu. The displayed values in the spreadsheet 
change and show now the circumference values  of 
the scale.
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Duplicating columns Because you’ll probably want to show more 
values than just the diameter, you should have 
at least two more columns to show these de-
sired values. There are multiple ways to add 
these columns:

When you open the column menu for a col-
umn (see above), you’ll find the menu com-
mand Duplicate this column at the end of the 
menu.

Open the column menu and choose Duplicate this 
column. You should now see two identical columns 
side by side in the spreadsheet. Use the column 
menu of the first column to change the designation 
of this column to  Ratio [1:n].

To speed things up, it’s possible to execute 
this procedure, duplicating a column and 
changing the designation, in one step:

Open a column menu for the second column and 
then hold down the ⌥ key. This changes the com-
mands in the upper part of the column menu to  
Add … Column variants of the normal commands. 
Choose the first command: Add  Deviation Column. 
This will add a new column with the designation De-
viation [HT] as third column in the spreadsheet.

Another way to add columns for a stop is to 
drag and drop the stop’s name from the stop 
list to the spreadsheet.

Click on the name Principal 8‘  in the stop list, then 
drag the name (while holding the mouse button 
down) into the spreadsheet. A bold, vertical sep-
arator line indicates where the new column will be 
inserted. For instance, drag the name between the 
Tones and the Ratio [1:n] columns. After releasing 
the mouse button a new column with the default 
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designation Ø [mm] is inserted as first column in the 
spreadsheet.

You can change the order of the columns as 
you see fit by clicking onto the name of a col-
umn (the pointer changes to a closed hand 
icon) and, while holding the button pressed, 
moving the column to the desired place. 

Move the second column (Ratio [1:n]) to the end of 
the table. 

One last way to duplicate columns is to hold 
down the ⌥ key when moving a column. 
When doing so, the moved column will be 
duplicated at the new position.

Moving columns

Change a column’s 
width

The width of each column in the spreadsheet 
is adjustable. Move the mouse pointer onto 
the vertical separator line between two col-
umns in the column header. The mouse point-
er changes to a move icon. Then click and 
drag the separator line to the desired position. 

Decimal placesWith the submenu Decimal places in the col-
umn menu you can designate how many deci-
mal places will be shown.

Change the decimal places preferences of the col-
umn Ø [mm] to 0. The diameter values are now 
shown as integer values.

Filter displayed half 
tones

Since most of the time only the C and F# val-
ues are of interest, the spreadsheet is filtered 
in that way by default. Of course, you can 
changed this filter to show all available half 
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Saving a document

Renaming a 
document

Duplicating a 
document

Mac OS X also auto-saves 
documents.

Save your previous work so that you can use 
it again later on. Use the Save command from 
the File menu. As this document has not been 
saved yet, the standard save dialog box will 
be opened in which you set the storage path 
and name of the document. Choose a path and 
name the document, e.g. Practice.

After saving, the document’s window title 
will adapt the new document name. 

After a document has been saved, the dialog 
box will no longer appear, the data and chang-
es therein will be stored under the same name. 
To save a document under a different name 
(i.e. change its name), choose Rename… from 
the File menu.

You can also base a new document on the 
contents of an existing on. After opening the 
base document, choose Duplicate from the 
File menu. This will create a copy of the base 
document. When saving this copy for the first 
time, you can choose a new path and name for 
the duplicated document.

tones. To do so, open the column menu of the 
Tones column by clicking on the designator 
C-F#. You can then choose between All Half 
Tones, Only C-F# and Only marked. The lat-
ter option shows only half tones which were 
previously selected by clicking on the tone 
names in the Tones column.



17Chapter 2

Opening Documents • Moving scales • 
Positioning • Grid • Adding, changing 
and deleting anchor points

Chapter 2

If not already open, open the document file  
Practice, you’ve created and saved in the last 
chapter, by choosing the command Open… 
from the File menu.

The next exercise will be moving the pres-
ent scale Principal 8‘  parallel to a new posi-
tion. In order to be able to see how the values 
change, make sure both views, the graphics 
view and the spreadsheet are visible. If neces-
sary, switch the segmented control in the up-
per right of the window to the middle position 
or use the command Show Number & Graph-
ics View from the View menu. If needed, re-
size the window and move the separator line 
between the views to have a good overview 
on both views.

Select the scale Principal 8‘. You can tell if 
it is activated when the name is framed and 
the anchor points are shown (in our present 
case, the beginning and end are marked with 
a small black square). To activate the curve, 
click either on the line or on the name. 

To deselect a scale, click anywhere in a free 
region on the graphics view.

When the scale is activated, it can be moved 
by clicking on it and holding the mouse but-

Opening documents

In addition to dragging the 
separator lines directly, you 
can also resize the views by 
dragging one of the handles 
at the bottom of the window.

The scale is also activated if 
you click on the name in the 
stop list.

Moving a scale
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ton while dragging the curve up or down. The 
values in the spreadsheet will be corrected to 
the new position immediately.

While moving the scale you can observe the 
position panel in the tool bar below the graph-
ics view of the mouse pointer at any time. You 
can change the parameter so that the panel 
shows diameter instead of horizontal and ver-
tical deviation from NM.  

Click on the type designator in the position 
panel to open a context menu to change the 
displayed type of scale.

This way, it’s easy to move a given scale to a 
given diameter.

Position panel

Grid It is possible to establish a grid for drawing 
and moving operations so that undesired val-
ues are omitted. With the grid it is easier to 
move e.g. a scale exactly »3HT« up or down.

Actually, there are two grid positions: a hori-
zontal or half tone and a vertical or deviation 
position. For the moment we are looking at 
the deviation position, Snap to Vertical Grid. 
Choose this command from the Tools menu. 
Now the scale can be moved only in incre-
ments of a half tone. To deactivate the grid, 
choose the Snap to Vertical Grid from the 
Tools menu again.

For short term usage, simply press the shift 
key (⇧) while moving the scale. The shift 
key is the general shortcut key for the entire 
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Modifying scale 
curves

Normally a straight line scale parallel to NM 
will not be desired. Of course scales can be 
modified by different means.

M! has two basic drawing modes:

1.	 Spline mode (Bézier curves)
2.	 free-hand mode

The default setting is spline mode. You can tell 
the spline mode is turned on, when the scale 
has anchor points (the small black squares). 
As well, the current drawing mode of a stop is 
displayed in the stop’s settings window.

You might be familiar with spline mode from 
other illustrator or CAD applications. At first, 
it will rake some practice, after a short time, 
you’ll find it much easier and more flexible 
to work with this tool when using the mouse 
than in free-hand mode. Don’t be discouraged 
if at first the curve doesn’t want to »behave«.

Imagine a spline as a magnetic rubber band 
pulled into position by several sources. The 
simplest is, of course, a straight line between 
two anchor points or coordinates. One such 
line is our Principal 8‘ . Now, you can change 
such a line simply by »grabbing« one of the 
anchor points with the mouse and dragging 
it while holding the mouse button down. The 
spline stays drawn between the anchor points.  

application: as long as it is held, drawing and 
moving operations snap to grid.

Bézier curves

Bézier functions are poly-
nomials, of all orders, also 
called Bézier polynomi-
als. Currently in vogue as 
smoothing curves in comput-
er graphics, e.g. for shap-
ing scalable fonts. In these 
applications they might be 
also called Bézier splines. 
A spline is a flexible ruler 
used for drawing curves. 
Bézier, who worked for Re-
nault, found and applied 
Bernstein polynomials (by 
which they might be known 
in earlier reference books) 
and promptly renamed them, 
by which Bézier name they 
are now known.
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Move the left anchor point to +1HT (if needed, 
switch on the HT and Deviation grid or hold down 
the shift key) and the right anchor point to +10HT.

To further modify the scale, insert a third 
anchor point. Change the tool from pointer 
to pen in the Tools menu (or by clicking on 
the respective icon in the tool bar below the 
graphics view). 

Click at half tone c13 and the deviation +4HT, fol-
lowing the visible grid or the values in the position 
panel in the tool bar. Click at half tone c13 on the 
curve.  

It might be helpful to set the 
position panel below the 
graphics view to Deviation 
[HT].
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You can move anchor points 
with the pen but be careful 
not to accidentally insert 
further anchor points while 
doing so by click next to the 
one you wish to move.

The new anchor point will be inserted at the 
designated position and the scale will now 
conform to all three points. Should the new 
coordinate not be at exactly the right place, 
you can easily move it as we have learned.

Splines are of course curves and so it is natural 
that you can use this function to draw curves 
as well. Do this by modifying »hard« cor-
ner points to »soft« curve points. Such curve 
points have, as opposed to corner points, han-
dles. While the »rubber band« remains taught 
between the anchor points, the handles influ-
ence it like strong magnets. You will grasp 
this most readily by changing the middle an-
chor point to a curve point. 

Click with the right mouse button on the anchor 
point in the middle. This opens a context menu. 
Choose Curve Point from this context menu. 

The curve point has two handles (×), that are 
not necessarily equidistant from the point, 
but are always connected by a straight line 
through the curve point. Try moving a han-
dle. Notice how the »rubber band« follows the 
movements.

Besides the curve point, the context menu 
offers the option Connection Point. This dif-
fers from the curve point in that the handles 
need not necessarily be on a straight line with 
the anchor point itself. Thus, it is possible to 
smooth »hard« corners into curves.

With a little practice you will be able to work 
quickly and intuitively.

If there’s no right mouse but-
ton, you can alternatively 
hold down the Ctrl key and 
click on the anchor point.

To insure that you do not 
accidentally insert anchor 
points in the following steps, 
it is better to change the tool 
back to Pointer.

Curve points always have 
two handles, except when 
they are endpoints of the 
spline. These naturally have 
only one handle towards the 
curve.

Please note that M! does not 
allow handles that would 
make loops in the scale!
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Here are a few tricks with which you can ac-
celerate working with splines:

•	 If you hold down the shift key (⇧) while 
moving a handle, the movements of the 
handles snap to the grid.

•	 Holding down the ⌥ key make the handle 
opposite the one being moved assume an 
equidistant position.

•	 Holding down the command key (⌘) 
causes the pen to change to the pointer.

•	 Holding the mouse button pressed when 
inserting a new anchor point changes this 
to a curve point which can immediately be 
»handled« with the mouse.

Naturally, you can delete individual coordi-
nate points. Delete for example the middle 
anchor point of Principal 8’. 

Activate that anchor point by clicking on it (the black 
square will change to a hollow frame) and pressing 
the backspace key (←).

Another possibility is choosing the Eraser 
from the Tools menu and clicking on the an-
chor point with it.

To end this section, here is another little ex-
ercise:

This temporary changing 
of tools works for the other 
tools as well.

Inactive anchor 
point

Active anchor 
point

This exercise is easier when 
both snap to grid options are 
turned on.

Delete all of the anchor points except the two end 
points of Principal 8’. If you have moved the ends 
since our last exercise, replace them at +1HT (left) 
and +10HT (right). Now insert at c13, c25, c37 and 
c49 new anchor points with +4HT, +6HT, +8HT and 
+10HT deviation. Since our stop is to have a com-
pass to a58, move the right endpoint to this half tone.  
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Now try to smooth this new scale modifying the an-
chor points to curve points and moving the handles.

The second method for drawing curves is the 
free-hand mode. It is use mostly for drawing 
with a graphic pad and stylus, but the mouse 
can be used in this mode as well.

You can tell that free-hand is turned on when 
the scale displays no anchor points but is 
drawn as a simple bold line. As well, the cur-
rent drawing mode of a stop is displayed in 
the stop’s settings window.

To change a spline into a free-hand curve,  
click in the stop list on the »i« button next to 
the stop’s name. This will show the stop’s set-
tings window. In the section Name, Graphic 
& Compass you’ll find the option Line type. 
Set this option to Bézier for spline mode or to 
free form for free-hand mode. Please read the 
margin notes to this topic as well!

The function of free-hand should be self-ex-
planatory. 

Free-hand mode

Please note that a spline that 
is calculated on the basis of 
a free-hand curve is always 
made up of corner points, 
not curve points, and this 
can cause problems with 
curves. Besides, the complex 
calculations lead to round-
ing off errors that will show 
up in the spreadsheet at the 
second decimal place. Mod-
ifying a »jagged« free-hand 
scale normally does not 
cause any problems.

Change the scale Principal 8‘ to a free-hand scale 
and modify it with the Pen from the Tools menu. You 
can shorten or delete all or part of a free-hand scale 
with the Eraser tool from the Tools menu.

Return to the previous version of Principal 8‘ 
by using the Revert to command from the File 
menu.

Alternatively, you could re-
vert the changes by repeat-
edly undoing your changes 
with Edit > Undo.
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Chapter 3Column types in the spreadsheet • 
Free columns
Lets have a look at the other value parameters 
of the spreadsheet. 

Open the column menu of on of the Principal 8‘ 
columns.

The categories Deviation [HT], Diameter 
[mm], Circumference [mm] (normally re-
ferred to as plate width PW) and Half Plate 
Width  [mm] should be self-explanatory.

The category Mouth Width [mm] show the 
same-named scale of the stop, normally de-
rived from the ratio stipulated in the Stop 
preferences (see »Stop preferences« at page 
33). The default setting is 1:4, i.e. the MW 
is 1/4th of the circumference PW of the note. 

Ratio [1:n] shows the fractional division of 
PW for MW: 1:n. In our present case, every 
note displays the same default value, 4. The 
real usefulness of the is column will later be-
come apparent when we get into variable MW 
scales (see »Free-variable mouth scales« at 
page 47). 

The category Pipe Depth [mm] gives the 
depth of rectangular pipes; the pipe width is 
considered to be the same as the MW.

The Theoretical Length [mm], abbr. lth, of a 
pipe is determined from its air column wave 
length for a given pitch (default a=440cps.) 
and ambient temperature (default 15°C=59°F) 

The brackets show the unit 
of measure.

In a later chapter 
(»Free-variable mouth 
scales« at page 47), we 
will see how to work with 
variable MW scales and 
progressions.

Columns and value 
parameters in the 
spreadsheet
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and temperament (default equal temperament 
- ET or better 12tet)

M! can approximate end compensation EC for 
three different types of pipes:

•	 Open pipes: parameters of the calculation 
are cutup area (cutup averaged as NM 
PW/16 - 1/4th of MW 1:4) as well as the 
pipe body measurements. Tapered and re-
verse tapered form are considered.

•	 Covered pipes: The body length (not the 
tuned length with hat of metal pipes) of 
covered pipes is arrived at by subtracting 
twice the Ø from 1/2 lth: body length = 
lth/2 - 2 × Ø.

•	 Chimney flute (Rohrflute)  (for tube Ø 
= 1/4 pipe Ø and tube length = 1/4 pipe 
length): body length is calculated as above 
but with lth +2 half tones: body length = 
(lth + 2 HT)/2 - 2 × Ø

The calculated approximations are all slightly 
smaller so that the listed values for pipe length 
are larger than the actual tuned pipe will have. 
The variation for open pipes lays between a 
few millimeters and several centimeters, de-
pending on pitch and scale.

The category lth-EC [mm] displays the ap-
proximated pipe body lengths. Please remem-
ber that the values are larger than the tuned 
pipe will have. 

Apart from foot notation that 
is given individually to each 
stop, all of the other param-
eters for length can be set in 
the Document preferences 
(see »Document preferenc-
es« at page 81).

Pipe length is, among other 
things, dependent on

a)	Ø
b)	MW
c)	pipe body form
d)	cut-up
e)	wind pressure (loudness)
f)	 method of tuning

a) and b) are quite simple 
to ascertain and to compen-
sate. The other parameters 
are so subjective that calcu-
lated lengths must necessar-
ily remain approximations.

As opposed to the Scaling 
slide rule, M! does not make 
an addition to the »correct-
ed pipe« length (lth-EC) for 
tuning slots.

If you have values for certain real pipes (as in 
a restoration), you can calculate the missing 
lengths for 12tet by entering these values into 
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Besides using the mouse, 
you can of course use the 
cursor to select and the en-
ter key to enter a change.

Has nothing been entered into this column yet, 
M! indicates mean values (C/16). These mean 
values are recognizable by the parenthesis. If 
single values are entered they are marked with 
a arrow (→). When at least two values are giv-
en, M! automatically interpolates all interme-
diate values automatically (geometric series).  

Example:

C1	 (30,5)	 mean Value
Fs7	 →20,0	 entered Value
c13	 16,1	 interpolated Value
fs19	 →13,0	 entered Value
c25	 (10,8)	 mean Value

The values of the Cut Up 
column are part of the cal-
culation of the end compen-
sation.

Cut-Up

the column category calculated length for the 
known pipes. 

To begin, all notes will show only »---« be-
cause at least two values are necessary to cal-
culate. 

Enter the known values by double-clicking 
the note in this column, enter a value and hit 
the return key (↩). The entered values are 
marked with an arrow (→). The unknown be-
tween these entered values are immediately 
calculated for ET and listed in the column. 
Entering a new known value between the pre-
vious causes those affected to be recalculat-
ed. To remove an entered value, double-click 
on it, delete with the backspace (←) key and 
press the enter key to finish the operation. 
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Free columns are suitable for any kind of text 
as well as for values and formulas.

Free Columns

Thickness of Material In columns of the mode Thickness [mm] the 
thickness of pipes can be recorded. If values 
have been entered here (and only then!) col-
umns of the category Ø, C, HP and D can be 
chosen to show resp. enter external measure-
ments apart from the common inside dimen-
sions. To have one of the above mentioned 
kind indicated as external measurement, you 
select the Out option in the column menu, the 
column title is thus extended by -Out. 

Below the categories in the column menu you 
will find different preference commands for 
the columns:

Top Scale (End): When this is turned on 
(checked), the upper Ø of non-cylindrical 
pipes is shown in the categories Ø, Circum-
ference, Half Plate Width, and Pipe Depth.

Factor…: As already noted, you can enter a 
factor here with which to multiply all values 
of the given column.

Decimal places: In this submenu you set the 
number of decimal places desired.

Lock: When this is turn on (checked), no val-
ues of the affected column can be changed, 
none entered or deleted. Thus, you protect 
against accidental changes. More about en-
tering numerical values in the next chapter. 
Locked columns are designated by a lock 
icon.
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You create a free column by selecting the Free 
category from the column menu. A window 
appears into which you can enter a column 
title. After confirming with OK, an empty col-
umn with the title chosen is indicated in the 
spreadsheet. Now you can make any entry 
you wish.

You can alter the title of 
free columns later by again 
choosing the indication type 
Free from the column con-
text menu. The contents of 
the column are thus not af-
fected.

Entering Formulas

Links in Formulas

The numeration of the col-
umns includes the letters A 
to Z. If there are more than 
26 columns in the spread- 
sheet, the numeration is con-
tinued »two-placed« (AA, 
AB, AC,...BA, BB etc.).

Capitalization is of no im-
portance for links. 

Please make sure not to take 
a link for a tone!

You may apply formulas in the free columns. 
To define an entry as a formula the first given 
symbol has to be a sign of equality (=). 

If you, for instance, enter »2+4«, the term is not be-
ing calculated and is shown unaltered. If, however, 
you enter »=2+4« this term is treated as a formula 
and calculated; M! indicates the value 6.

Apart from basic arithmetic and numerical 
values you can also apply links to other col-
umns in the formulas. Links to other columns 
consist of letters and numerical values. The 
letters refer to the column (the according let-
ters are indicated at the head of the spread-
sheet: A, B, etc.) whereas the numerical part 
refers to the line resp. the half tone (1 to 61). 
The link C52, for example, refers to the half-
tone d#52 in column C. The columns resp. 
half tones which are referred to can also be 
hidden (e.g. half tones by setting only C-F# or 
columns by hiding the corresponding stop in 
the graphic view). When you are in the input 
mode of a free column you can set links by 
simply clicking the corresponding part in the 
spreadsheet.
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Fill Up/Down

Fixing Links

You can apply the Fill Down resp. Fill Up 
commands from the Edit menu for multiply-
ing constant values, texts or formulas. To do 
so, you mark the section which is to be filled 
in, whereas the value marked last has to be the 
one that is to be copied. Then select either the 
Fill Down or Fill Up command.

A peculiarity is effective for formulas: Links 
in formulas are adjusted to the new position 
when filling in. Thus you can set a formula 
for a tone and then apply it accordingly for all 
other half tones.

If you wish to stop this adjustment (for in-
stance to always refer to a base tone in a filled 
in section) enter »$« after the link. 

Example: In the formula =2*A$1+B2 the link 
B2 is adjusted with the Fill Down command 
the fixed command A$1, however, is not!

When columns are moved or erased the af-
flicted links automatically adjust to the new 
situation.

With free columns you can also create com-
plex tables, such as cut lists for wooden stops, 
directly in M!:

Create a new stop 8‘ covered. Open the column 
menu of the Tones column and choose the option 
All Half Tones.

Then copy the Ø column of the spread- sheet 
an change into the indication mode of both 
columns Pipe Depth and Mouth Width.

This step is explained later 
in more detail. See »Cre-
ating a new stop« at page 
33.

Example: Cut list
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Open the column menu of the first column, hold 
down the ⌥ key and choose Add Mouth Width 
Column. Open the column menu of the first column 
again and choose the category Pipe Depth (without 
holding down the ⌥ key).

The columns now already show the measure-
ments of the pipes. Now copy a column of the 
stop and set the column type Thickness. 

Open the column menu of the last column, hold 
down the  ⌥ key and choose Add Thickness Col-
umn.

Enter the thickness of material into this col-
umn. 

In the column Thickness, enter the value 0.6 at half 
tone C1. Then select all cells in this column by click-
ing onto the stop name 8’ covered in the column 
header. Then choose the command Fill Down from 
the Edit menu.

Now you can mark the Out option from the 
context menu of the Pipe Depth column.

Open the column menu of the column Pipe Depth 
and choose the option Out. 

Thus the cut width is indicated in this column.

Create yet another column and set it for the indica-
tion type lth-EC. 

Since extras have to be added to the indicat-
ed lengths (e.g. for stoppers etc.) you cre-
ate another two columns which you declare 
Free with the corresponding column context 
menus. 

In a real world application, 
the thickness value wouldn’t 
be constant throughout all 
half tones. It’s only to sim-
plify this example.
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Open the column menu of the last column and 
choose Duplicate this Column. Open the column 
menu of the duplicated column, choose the cate-
gory Free… and enter Extra Length as column title. 
Repeat the whole procedure one more time, but 
name the column Cut Length this time.

Now you can directly set absolute values for 
the Extra Length column. In this example, 
however, an extra length of 10% of the cor-
rected length is to be added for each pipe.

Enter the following formula into the Extra Length 
column at the halftone C1: =D1/10

After leaving the field M! immediately cal-
culates the given 10% of the corrected length 
(from column D).

To carry out this calculation for all half tones, mark 
the entire column and select the Fill Down com-
mand from the Edit menu. 

Thus the formula is copied into all lines. The 
link to the corresponding halftone in column 
D is adjusted automatically..

For calculating the final cut length you now enter 
the following formula into the Cut Length column at 
the halftone C1: =D1+E1

Fill in the formula for all halftones in this col-
umn with the Fill Down command.

.

In the following exemplary 
formulas it is assumed, that 
the lth-EC column bears the 
column letter D, the Extra 
Length column the letter E 
and the Cut Length column 
the letter F. If your spread- 
sheet bears other letters, 
modify the formulas accord-
ingly.
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Chapter 4Creating stops • Stop preferences • 
Constant progressions • Broken scales 
• Free-variable scales (addition con-
stants) • Standard scale

Next to the scale Principal 8’ we shall make 
some new scales to demonstrate the different 
possibilities.

Choose New Stop from the Scaling menu. 

A new stop with the name Untitled is added 
to the stop list. This stop is initialized with 
the default stop preferences (8’, cylindrical, 
open).

 

Click on the »i« button next to the new stop’s name. 

This opens a popover window, which contains 
the stop’s preferences. The popover window 
automatically closes if you click outside its 
bounds, somewhere in the main window.

To keep the stop preferences window open for 
a longer time or maybe open stop settings of 
multiple stops at the same time, it’s possible 
to tear a popover window off. The stop prefer-
ences window will change to a »normal« win-
dow which can be moved around and stays 
open until closed manually.

To tear off a popover window, click into an 
empty region inside the popover window and 
drag the mouse.

Alternatively, just click on 
the + button below the stop 
list.

Creating a new stop

Stop preferences

The stop preferences win-
dow contains several sec-
tions. The title bar of each 
section contains a triangu-
lar button. By clicking on 
one of these buttons, you can 
toggle the visibility of the re-
spective section. M! remem-
bers the visibility settings of 
each section, so the hidden 
sections stay hidden the next 
time you open a stop prefer-
ences window.
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Name, Graphics & 
Compass

This section contains an edit field to change 
the stop’s name. Next to the edit field, you’ll 
find a color well. Click on this to change the  
color of the stop in the graphic view.

The option Automatic Name Positioning con-
trols if the stop’s name is positioned automat-
ically in the graphic view (left of the grid at 
height of the first anchor point). See »Free 
placement of names« at page 64 for infor-
mation on how to manually position a scale’s 
name in the graphic view.

The option Line type can be used to set the 
drawing mode of a scale in the graphic view 
to either Bézier (Spline) mode or free-hand 
mode. See »Modifying scale curves« at page 
19 for more information.

Enter the Compass of the stop with help of the 
pop up menus for the first and last half tone 
of the stop. This limits the scale to the entered 
values.

First, enter a name for the new stop: Tierce 1 3/5’. 

Obviously a 1 3/5’ stop, you set the proper 
foot tone level in the next section.

Please note, that subsequent 
changes of the compass tem-
porarily change the scale to 
freehand mode. If a scale’s 
line contains curve points, 
these will be changed into 
corner points.

Foot tone level
Enter the foot tone level of the stop in this sec-
tion. To choose a foot tone level, click on the 
Set button. Note that the different mutations 
are ordered as to overtone interval:
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Select option 8/5=1 3/5 in the Thirds section. Close 
the foot tone level window by clicking outside of its 
bounds.

Covered StopsIf you select Covered in the pop up menu in 
the section Type & Body, M! calculates the 
end compensation according to the formula 
MK=2×Ø.  

If you select Chimney Flute (Rohrflute), the 
end compensation is also calculated as above, 
but with lth + 2 half tones (Chimney-Ø = 1/4, 
Chimney length = 1/4 body length). 

In either case, the theoretical length is the 
same as with an open pipe..

Non cylindrical pipes are explained in a lat-
er chapter (see »Non-cylindrical pipes with 
free-variable ratio« at page 61).
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Mouth Scales

2’, c13 = 25mm Ø, 
following NM

The next stop will be one that does not begin 
with the Ø value of NM: a 2’ with a c13 value 
of 25mm.

Choose again New Stop from the Scaling menu. 
Then open the settings window for the new stop 
by clicking on the »i« button next to the new stop’s 
name in the stop list. Change the name of the new 
stop to narrow 2’.

Now change the foot tone level of the new 
stop:

In the section Foot Tone Level, click on the Set 
button and choose the option 2’ from the Octaves 
section. 

This stop should have a constant ratio of 1:4.5. 
A constant ratio for the mouth width can be 
entered in the Mouth Width section of the stop 
settings window.

Enter 4.5 into the edit field next to the Constant op-
tion in the Mouth Width section.

We don’t change any other setting for now. 
Other options, like variable mouth width or 
conical pipe bodies are handled later.

Close the popover window with the stop’s settings 
by clicking outside of its bounds (in case you’ve 
»teared off« the popover window, click on the red 
close button in the settings window’s title bar).

The new stop appears automatically in the 
spreadsheet as well as in the graphic view.
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Initially, this will show the first note of the stop 
length in NM (8’ - C1 = 155.5mm, other par-
tials to pure intervals, i.e. 2’ - C1 = 54.98mm). 

Select the option Free Ø and enter the new value 25 
into the edit field below.

Since this is not the diameter of C1 but of c13, 
you want to change the Base tone setting ac-
cordingly:

Choose c13 from the Base tone pop up menu.

The entries in the Foot Tone Level window 
should now look like in the screen shot on the 
right.

Close the window Foot Tone Level by clicking into 
the stop settings window behind it.

The changed settings are also displayed in the 
section Foot Tone Level in the settings win-
dow:

On the spreadsheet, you can see that M! has 
calculated the values for this stop so that c13 
intersects Ø 25mm. Apart from that, the scale 
is parallel to NM (halved at the 17th).

Please note that the graphical representation 
of this scale is identical with NM. 
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The generated scale is superimposed on NM 
because NM is still stipulated as progression 
(halving at the 17th), only the given initial di-
ameter is different. Graphically, this is only a 
horizontal replacement of the scale curve.

If you wish to compare this to a »normal« 2’ 
stop graphically, you must go about this as 
follows (see also the notes in the side bar):  

Add a new stop. Open the stop’s settings window 
and rename it to 2‘ manually. Set the foot tone level 
simply to 2’ but do not change any other settings. 

Set the position panel below the graphic view 
to Diameter [mm] (click on the position panel 
to open a context menu, see »Position panel« 
at page 18). For easier access, its best to 
hide the other scale (narrow 2’) by deselect-
ing the check box in the G column next to this 
stop in the stop list (see also »Stop visibility« 
at page 41).

Move the scale in the graph view by clicking at c13 
and dragging it down until the position panel dis-
plays 25mm. 

The values will be identical to narrow 2’. 
Which method you choose will depend on 
your intention.

For those familiar with the 
Scaling slide rule:

The first method is the same 
as setting the slide so that 
»25« on scale »④ Du« is 
under »c13« of the NM scale 
on the body. The remaining 
diameters can be read di-
rectly for NM for each note.

The second method is done 
as follows: set »2’« on scale 
»⑤ Al« to HT C0 on the 
body. Set the hairline edge 
to this position, too. Lay the 
slide rule on a sheet of scale 
paper so that the marking 
edge lays on ±0 NM. When 
you set the hairline edge to 
»25« on scale »④ Du« you 
can mark on the paper at 
c13 for this scale and read 
off the deviation. If you wish 
only to read, use the hair-
line itself (though it makes 
no difference). Transferring 
the necessary values for the 
scale will give you the nec-
essary point on the paper 
to draw the scale. Then you 
can read off any note.

Refer Graphical 
Representation to 

NM

The above manual dragging of the stop’s scale 
line can also be done automatically by M!

Unhide the scale narrow 2’ in the graphic view by 
checking the check box in the G column next to the 
stop’s name in the stop list again.
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Open the stop settings window of narrow 2’. 
The display in section Foot Tone Level should 
still look like this:

By clicking the button Refer graphical repre-
sentation to NM, M! shifts the scale in a way 
that the graphical representation can be read 
without a shifting of the origin.

Click on Refer graphical representation to NM.

The scale of narrow 2‘ should now have 
been moved vertically down, so it’s now at 
the same height as 2’ manually. The section 
Foot Tone Level should now display simply 
2’ (without any diameter additions) since the 
displacement is now represented by a graphi-
cal displacement of the scale and not calculat-
ed internally as before. The numerical values 
of the scale are thus not altered!

The following example will explain how you 
can generate curves with progressions other 
than NM. M!’s default setting is the so-called 
Töpfer normal scale (NM), 1:∜8 octave ratio 
or halving at the 17th.

Now, we want to make a scale with a different 
progression: 1:1,664 (3:5).

The default progression can 
be defined in the document 
preferences (see »Document 
preferences« at page 81).

Other constant 
progressions
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A underlined progression 
denote that the progression 
is the default progression of 
the document, not a manual-
ly inserted one (see »Docu-
ment preferences« at page 
81).

Create a new stop and open its setting window. Re-
name the stop to 8’ Prop: 3:5. 

The correct 8’ foot level is set by default. Now 
set the new progression in the section Pro-
gression. The table in this section currently 
shows the default settings of the document: 

The entry 1:∜8 (1/2 on 17th) is the Töpfer nor-
mal scale (NM) and it’s valid for all calculat-
ed half tones (C1 to c61).

Double-click on this table row in order to 
open a edit window for this entry. Besides 
some standard options for the new progres-
sion, there’s also an option to enter a free pro-
gression. 

Select the option next to the edit field and enter 
1.664 into that edit field. Then click on the Change 
button.

The table in the section Progression now dis-
plays the new progression:
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On the graph you see the new scale as diag-
onal straight line, beginning at NM (± 0HT), 
the starting diameter set in the stop preferenc-
es by default and not changed by us. Because 
the progression is stronger, the line rises to the 
right, giving an increasingly wider scale.

On the spreadsheet you can see that the cor-
rect progression has been used: The diameter 
c13=93.45 does correlate to C1=155.50/1.664.

Deleting columns in 
the spreadsheet

If find the spreadsheet to be cluttered, you can 
delete columns of possibly uninteresting data 
by choosing Remove this column from the 
column’s menu. This deletes only the chosen 
column, the other data and the scale itself on 
the graph remain untouched.

Stop visibilityAnother option to organize visibility of stops  
in the spreadsheet (and graphic view) are the 
show/hide check boxes in the stop list view. 
To the right of the stop names are two addi-
tional columns: S and G. The check boxes in 
the  »S« column control the visibility of the 
stops or groups in the spreadsheet. Links to 
hidden columns in formulas aren’t affected by 
the visibility settings.

The check boxes in the »G« column control 
the visibility of scales in the graphic view.
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Broken scales Changing from one constant progression to 
another in one scale give a so-called broken 
scale.

Create a new stop and open its setting window. Re-
name the stop to 8‘ broken. 

To add additional rows to the Progression ta-
ble, use the »+« button below the table. If a 
row is selected, you can remove this row by 
clicking in the »–« button below the table.

Click on the + button below the Progression table.

This opens a window in which you can enter 
the progression of the new section.

Use the pop up menus at the top to set the range 
for this progression: C1 to c13. Click on the option 
button for entering a free progression and enter the 
desired progression, in this case 1.6, into the edit 
field.  Now click onto the Add button to add the new 
section to the progression table.

The progression table contains now two rows. 
In the graphic view, you can see the scale ris-
ing from C1 to c13 (since the progression for 
this range was set to a »wider« value as the 
base progression (1:∜8 = 1:1.6818) of the 
document). From there on, the scale runs par-
allel to NM.

Add another row to the progression table. This 
time, set the range from c37 to g56 and enter the 
progression ratio of 1:1,714.

In the progression list you will now see how 
the broke scale is divided up.

There is an unlimited possi-
ble number of segments in 
the progression list.
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Now set the foot tone level at 8’ and the start 
Ø at C1=130mm in the foot tone level win-
dow.

Click on the Set button in the section Foot Tone 
Level. Select the option Free Ø and enter 130 into 
the edit field below this option. Close the foot tone 
level window by clicking outside its bounds.

The settings window of the stop should now 
look like the screen shot on the right.

On the graph, you can shorten the scale to 
g56, your projected last note:

Select the last anchor point of the scale (HT c61) in 
the graphic view and hit the backspace key (←) to 
delete it.

On the spreadsheet you can now check the 
values in the column 8’ broken (Ø [mm]):

Optionally, you can set the 
compass also in the Section 
Name, Graphic & Compass 
in the stop’s setting window.

Fixed-variable scalesFixed-variable scales are such that use a con-
stant geometric progression but modify this 
by adding or subtracting a numerical constant 
- a mm value - (addition constant) to generate 
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a new curve. Compared to NM, these curves 
are similar to exponential curves.

This is done in M! in the window which ap-
pears when you add a progression. 

Create a new stop and open its setting window. Re-
name the stop to 8‘ fixed-variable. Double-click the 
only entry in the progression table in section Pro-
gression.

A window to edit the double-clicked row 
opens. 

Select the option Addition constant and enter  5 into 
the edit field next to it. Finally, click on the Change 
button.

The table in the section Progression now 
shows the progression with its addition con-
stant: 

 

The graph now shows a ascending curve.

Thus, in the section Progression you can set 
any combination of different addition con-
stants and even broken scales for different 
parts of the range of the stop.

Standard scale By standard scale one means a single scale, 
extended at both ends, is used as a basis for 
several stops. In M! you can move scales hor-
izontally as well with the mouse.

In moving splines, scales 
are temporarily transposed 
to freehand, so curve points 
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Before move, duplicate the scale in question 
each time: 

Select a stop in the stop list. Then choose the menu 
command Duplicate from the Edit menu.

are lost and are finally simu-
lated by corner points.
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Chapter 5Mouth scales • Constant ratios • Free 
(variable) scales • Entering numerical 
values • Entering comments • Group-
ing scales • Macros

Constant ratiosConstant mouth scales are obviously solely 
dependent on diameter. The method for set-
ting the ratio of these has already been ex-
plained in chapter 4: simply enter it in the 
section Mouth Width in the stop’s settings 
window (see »Mouth Scales« at page 36).

Free-variable mouth 
scales

If the mouth scale is to be independent of the 
diameter, you must generate a separate scale 
curve for it. This scale should use the same 
parameters (foot tone level, progression) as 
the Ø scale in question. In order to make this 
process as easy as possible, M! provides an 
automatic function for this.

Create a new stop and open its setting window. Re-
name the stop to 8‘ free mouth. In the Mouth Width 
section, select the option Variable.

M! automatically creates an additional scale 
for the free-variable mouth scale and renames 
it accordingly (MW 8’ free mouth in this case, 
MW stands for Mouth Width). Internally, this 
new scale is automatically linked with the 
original scale 8’ free mouth. You see this link 
when you open the settings window of 8’ free 
mouth: In the section Mouth Width the option 
Variable now displays MW 8’ free mouth as 
the linked scale. To organize the liked scales, 
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M! also creates a new group 8’ free mouth, 
containing the original stop and the automati-
cally created mouth width scale.

Another method is to create the mouth width 
scale manually by copying and pasting the 
scale’s curve:

Open a new document with New from the File 
menu. 

A new document window is opened. This doc-
ument contains a default stop Untitled.

Open the settings window of this stop and rename 
it to 2‘ free mouth. Click on the Set button in the 
section Foot Tone Level and choose the option 2’ 
from the section Octaves. Leave all other settings 
unchanged and close the settings window.

Now generate the scale in the graphic view. 
Insert a further anchor point at HT c37:

Select the scale in the graphic view by clicking onto 
the name of the stop. Switch to the Pen tool and 
insert a new anchor point by clicking at HT c37 
and deviation +2 HT. Hold the mouse button down 
when clicking and drag the mouse to the left.

This changes the newly created anchor point 
from a corner point to a curve point. 

Drag the handle to the left until the mouse pointer 
reaches approximately HT c25. 

The scale should arch upward. 

Change back to the Pointer tool. Move the left an-
chor point vertically to a deviation of +6,5 HT. Move 
the right anchor point vertically to a deviation of 
+7,5 HT. With the right mouse button, click on the 

To make positioning the 
points easier, you want to 
switch the position panel 
(below the graphic view) to 
Deviation [HT].

Furthermore you might want 
to hold down the shift key 
(⇧) when adding or moving 
anchor points. This will tem-
porarily switch on the verti-
cal and horizontal grid. Op-
tionally, you can activate the 
grid also in the Tools menu.
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left anchor point and choose Curve Point from the 
context menu.

Since the left anchor point has been changed 
to a curve point, it now also displays a handle. 

Drag this handle horizontally to the right to HT A#11. 

The scale should resemble this:

On laptops or if your mouse 
doesn’t have a right mouse 
button, hold the ctrl key 
down when clicking the 
mouse.

Duplicating scalesNow, copy this scale with Copy from the Edit menu. 

Be sure that the scale is activated before doing 
this (if necessary, click on the line). 

Choose Paste from the Edit menu to duplicate the 
scale. 

Because it is superimposed on the original, 
it is not visible on the graph. In the stop list, 
however, you will find the second scale as 
well as in the spreadsheet..

Open the settings window of the copy and change 
its name to mouth 2’. Change the color for the scale 
as well by clicking on the color well next to the name 
edit field. For instance, choose a red color.

The curve of mouth 2’ should still be selected 
in the graphic view.
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Linking mouth scales 
to Ø scales

In the graphic view, click on the name of the mouth 
scale (mouth 2‘). Drag the name onto the name of 
the diameter scale (2’ free mouth), until the mouse 
pointer changes to an anchor icon. Then release 
the mouse button.

A dialog window Link mouth 2‘… appears. 

Click on the option …as Scale for Mouth Width. 

If not, select mouth 2’ by clicking on its name in the 
stop list.

Since mouth 2’ is selected, you should now 
see the curve’s anchor points in the graphic 
view.

Drag the left anchor point vertically to deviation 
+3,5HT, the right anchor point to deviation +4HT  
and the middle anchor point to deviation +6,5HT.

The graph should now look like this:

In order for the spreadsheet to be able to cor-
rectly calculate the mouth widths (for instance 
for EC) the mouth scale must be linked with 
the diameter scale.
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Add an additional column for the stop 2’ free 
mouth to the spreadsheet to display the mouth 
scale:

In the spreadsheet, click on Ø [mm] of column 2’ 
free mouth and hold down the  ⌥ key.

By holding down the ⌥ key, the category op-
tions of the column menu change to Add … 
column options. I.e. by choosing one of these 
options, a new column is created with the cho-
sen category.

Choose Add Mouth Width Column from the column 
menu.

Next to the column 2‘ free mouth Ø [mm] a 
new column 2’ free mouth MW (from mouth 
2’) is inserted.

As you can see, the values for MW of the stop 
are identical (if necessary, change the display 
of mouth 2’ to Mouth Width [mm]). Since the 
column mouth 2’ has outlived its usefulness, 
you can delete it.

Open the column menu of the column mouth 2’ and 
choose Remove this Column.

You can display the ratio for every note on 
the spreadsheet. Add another column to the 
spreadsheet:

Open the column menu for column 2‘ free mouth Ø 
[mm] and hold down the ⌥ key. Then choose the 
option Add Ratio Column.

Your spreadsheet should more or less look 
like this:

You can tell that the mouth 
widths are extracted from a 
separate mouth scale by fol-
lowing column header

2‘ free mouth
MW (from mouth 2‘) [mm] 

If the column is too narrow 
to show the entire heading, 
you can widen it with the 
mouse by dragging the sep-
arator line to the right (see 
»Change a column’s width« 
at page 15).
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Minor differences in the 
values are possible, since 
you’ve constructed the 
curves manually.

If a value is entered in the spreadsheet into a 
column which indicates the mouth width of a 
register with constant ratio, that makes a free 
mouth width necessary, M! automatically cre-
ates the necessary scale for the free variable 
mouth width and links it to the diameter scale 
according to your wishes.

Delete mouth 2’ by selecting this scale in the stop 
list and then clicking on the »–« button below the 
stop list.

You can see in the spreadsheet, that M! 
changed the mouth width of 2’ free mouth 
back to »constant«. The column Ratio [1:n] 
now displays the default ratio of 4.00 and the 
title of the mouth width column displays MW 
(1:4.00) [mm] as category.

Automatic scale 
for mouth width 

for numeric 
documentation
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To set the variable mouth width of 2‘ free 
mouth numerically, you can simply change 
the values in the column Ratio [1:n].

Double-click on the value at C1 in column Ratio 
[1:n] and enter 5. Then press the Return key (↩) to 
commit the changes.

This change will trigger M! to do the follow-
ing: 

Due to the change of the ratio at half tone C1, 
the mouth width of the stop changes back to 
»free-variable«, i.e. M! creates an additional 
scale for the mouth width, links it with the 
original stop and puts both scales in an auto-
matically created group, named 2’ free mouth.

In the graphic view, the anchor point of the 
mouth scale at C1 is moved to a deviation 
where the mouth width ratio equals 5. The 
curve of the mouth scale interpolates all half 
tones up to the next anchor point. You can see 
that in the spreadsheet: the ratio of the half 
tones between C1 and c37 (the half tone with 
the next anchor point) rises continuously from 
1:5 to 1:4.

If you enter a value for a half tone which 
doesn’t have an anchor point yet, a new an-
chor point is created. 

Enter a ratio of 3.5 at half tone c25. 

This creates a new half tone at c25. Please 
note, that automatically created anchor points 

The same way, you can also 
enter MW (from …) [mm] 
values.
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are always corner points. If you like to create 
smooth curves, you want to change the anchor 
points to curve points (or connection points) 
and adjust the handles manually.

Delete the anchor point at c25 by selecting it and 
then hitting backspace (←).

Comments in the 
graphic view

It is advisable to denote the basis of the free 
mouth scale on the graph.

Double-click in a free area of the grid. 

A text cursor will show: you can enter your 
comment.

Enter the text 1:4 and hit the return key (↩). 

The comment will show in italics. You can 
drag the comments around with the mouse. 
Best, of course, to put them next to their re-
spective scales. 

Drag the comment to the right end of the scale. 
Create a second comment by double-clicking into a 
free area in the grid again. Enter the text 1:5. Move 
this comment to the start of the scale on the left 
side.

The graphic view should now look like this:

To change the text of an ex-
isting comment, double-click 
on the comment to edit.

To delete a comment, either 
drag it into the margin area 
left of the grid or edit the 
comment and delete the text.
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To link a comment with a scale, i.e. the com-
ment has the same color as the scale and is 
hidden with it, drag the comment onto the 
scale name until the anchor appears. After re-
leasing the mouse button, the comment will 
still be where you put it first time, but it will 
have the color of the scale, etc.

For better visualization of the linked com-
ment, first give the scale 2’ free mouth a new 
color:

Open the settings window for the scale 2’ free 
mouth and click on the color well in the section 
Name, Graphic & Compass. Choose, for instance, 
a blue color.

Now, link the two comments with the scale 2’ 
free mouth.

Drag the comment 1:5 onto the name 2’ free 
mouth. When the mouse pointer changes to an an-
chor icon, release the mouse button.

The comment falls back on its original posi-
tion after releasing the mouse. You can tell the 
successful link with the scale immediately, 
since the text color of the comment changed 
to the scale’s color.

Repeat the procedure for the second comment: 
1:4.

Now hide the scale 2’ free mouth in the graph-
ic view to see that the comments also hide:

In the stop list, uncheck the check box in column G, 
next to the group 2‘ free mouth.

Linking comments
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Grouping scales Stops can be grouped together. Groups in the 
stop list are indicated by the triangular button 
left to the group’s name. Click on this button 
to fold or unfold the group’s contents.

Create a group by clicking on the folder button be-
low the stop list. This adds a new, empty group with 
the default name Untitled.

Renaming a group works the same way as 
with stops. 

Select the group by clicking on its name once. Then 
click on the name a second time to edit the group’s 
name. Rename the group to Great Organ.

Stops (and other groups) can be added to a 
group by drag & drop.

Drag the group 2’ free mouth onto the group Great 
Organ.

With help of the menu command New Group  
from Selection, it’s possible to group items 
without creating an empty group first.

Create two new stops: Subbas 16‘ and Octavbass 
8‘. Then select both stops (by holding down the 
cmd key (⌘) while selecting the stops) and choose 
the command New Group from Selection from the 
Scale menu. This groups the selected stops in 
anew group. Rename this group to Pedal.

Apart from the logical and visible aspects, 
grouping has definite advantages:

•	 you can hide and show all scales of a 
group at once by clicking on the check 
boxes in the S and G columns of the stop 

It’s also possible to select 
multiple stops by holding 
down the cmd key (⌘) or the 
shift key (⇧, for continuous 
selections) when selecting a 
stop.

The command New Group 
from Selection is also acces-
sible through a context menu 
in the stop list. Right-click 
on a selection in the stop list 
to open the context menu (or 
ctrl-click on laptops). 
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list. The check box in column S controls 
the visibility in the spreadsheet, column G 
the visibility in the graphic view.

•	 you can fold and unfold groups in the stop 
list to gain room or clarity. Once folded, 
only the group name is shown. To unfold 
or fold, click on the triangular button to 
the left of the group name.

•	 you can move groups as single units  (Drag 
& Drop).

Using arithmetic 
operations and 
macros

You can use fundamental arithmetic opera-
tions (+, -, *, /) while entering numerical val-
ues. After depressing the Enter key, M! calcu-
lates the statement in arithmetical order.

Macros for recurring operations like this can 
be made, too.

Here an example:

You have taken the scales of a historic organ; 
this is generally done by taking the circumfer-
ence with a paper strip. Of course, the inside 
circumference is the important measurement, 
so M! must deduct the metal thickness

Using these measurements:

	 HT	 Outside cir.	 Thickness
	 C 	 250mm 	 0.6mm
	 C# 	 245mm	 0.6mm
	 D 	 236mm	 0.6mm
	 D# 	 226mm	 0.6mm
	 E 	 215mm	 0.5mm
	 F 	 205mm	 0.5mm
	 …	 …		  …
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In a new document, create a stop Principal 4‘ (or 
rename the untitled default stop in the new doc-
ument). Set the foot tone level to 4‘. Change the 
category of the stop’s column in the spreadsheet 
to Circumference [mm]. Set the half tone filter of the 
spreadsheet to All Half Tones, by clicking on C-F# in 
the Tones column and choosing All Half Tones from 
the column menu.

The material thickness can be directly sub-
tracted from the circumference, for example:

At half tone C, enter the formula: 250-2*3.14*0.6

When hitting the return key (↩), M! calcu-
lates this as 246.23, the inside circumference 
of the pipe.

Material thickness is normally the same for 
several pipes, so using a macro to define 
thickness can accelerate the process:

C value: 250#-2*3.14*0.6#

After entering this statement, the same value 
as above is calculated, but additionally the ex-
pression between the two »#« has been stored 
as a macro. You can reduce the next statement 
to the value alone:

C# value: 245#

Instead of duplicating #, M! substitutes the 
macro for # and calculates:

245-2*3.14*0.6 = 241.23.

Of course, the outer scale 
could also be entered us-
ing M!’s built-in support 
for thickness columns and 
calculating outer scales. In 
that case, you would select 
the option Out in the column 
menu of column  Circumfer-
ence [mm] and add a second 
column with the category 
Thickness [mm]. You could 
enter the measured thickness 
values into the Thickness 
[mm] column and the out-
er circumferences directly 
into the Circumference-Out 
[mm] column. Although this 
might be probably the way to 
go, we would loose a fine ex-
ample for macros here.
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Redefining the macro is first necessary when 
the thickness changes, in our example at E:

E value: 215#-2*3,14*0,5#

After entering the changed data, the macro is 
changed, too, and can be used until it must be 
changed again.

The macro subroutine of the program works 
like this: The value in question is first scanned 
for the macro sign »#«, if there is only one 
»#« the stored macro is displayed instead of 
the value, if no macro has been defined, the 
»#« is ignored. 

If two »#«s detected, the entire statement be-
tween those »#«s is interpreted as a macro and 
stored.

Here is another (advanced) example of a mac-
ro:

1. statement:

250-#2*3.14*0.#6

defined macro:

2*3.14*0.

2. statement.

245-#6

interpreted:

245-2*3.14*0.6
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3. statement:

215-#5

interpreted:

215-2*3.14*0.5
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Chapter 6Non-cylindrical pipes: constant and 
free- variable • Free placement of 
names on the graph

In generating scales for non-cylindrical pipes, 
you can choose between a constant ratio of the 
upper and lower Øs and a free-variable ratio.

Tapered pipes with a constant ratio can be de-
fined directly in the stop settings window.

In section Type & Body you can enter a factor 
for the upper Ø. Select the option Body: Con-
ical (fix), then enter the factor into the  edit 
field. If the upper Ø is smaller than the lower, 
the value must be <1. If the upper Ø is larger, 
the value must be >1. 

Non-cylindrical pipes 
with constant ratio

To display the upper Ø on the spreadsheet, set 
one column to Ø [mm] and then select Top 
scale (End) from the column menu. This col-
umn will now show the upper Ø and the head-
ing is augmented by »-Top«.

The option Top scale is available for the cat-
egories Ø [mm], Circumference [mm], Half 
plate width [mm] and Pipe depth [mm].

Displaying end Øs in 
the spreadsheet

Non-cylindrical pipes 
with free-variable 
ratio

You can also make a separate scale for the up-
per diameter, exactly as you have done for the 
free-variable mouth scales, and link this to the 
Ø scale.



62 Chapter 6

When creating a scale for 
the upper Ø, be sure that the 
starting Ø or the optional 
free Ø and the foot tone lev-
el are commensurate. Make, 
if necessary, changes to the 
scale of the linked stop.

Open a new document. Change the name of the 
untitled default stop to Tapered Stop. 

Create a new stop for the upper scale:

Click on the + button below the stop list and re-
name the new stop to Upper Scale.

Change the curve for the upper scale:

Select the Upper Scale by clicking on its name in the 
stop list. Drag the left anchor point  in the graphic 
view vertically down to a deviation of -5HT. Change 
the right anchor point to a curve point (right-click 
on the anchor point to open a context menu). Then 
drag the handle of the right anchor point horizon-
tally to c25. 

The scale arches upward and should look 
about like this:

Now drag the name Upper Scale onto Tapered 
Stop. 

After releasing the mouse, a window Link Up-
per Scale… opens.

Click on ... as Scale for Upper Diameter (Mouth) in 
the link window.  

The two scales are linked now.
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Delete the redundant column Upper Scale Ø 
[mm] in the spreadsheet:

Choose Remove this Column in the column menu 
of column Upper Scale Ø [mm].

Duplicate the remaining column Tapered Stop 
in order to display both, the lower and the up-
per diameters.

Choose Duplicate this Column in the column menu 
of the column Tapered Stop Ø [mm]. Then select 
the option Top Scale (Mouth) in the column menu of 
the duplicated column.

The two column now display the upper and 
lower Øs of the stop. It is obviously a tapered 
stop approaching cylindrical in the treble.

It is recommended, as with free-variable Ø 
scales, to group these related scales together 
in the stop list.

If you let M! create the upper scale for you, 
the grouping is handled automatically:

Create a new stop by clicking on th + button below 
the stop list. Open the new stop’s setting window 
and rename it to 8’ conical.

The following step triggers M! to create the 
second scale for the upper diameter automat-
ically:

In the settings window in section Type & Body,  se-
lect the option Conical (var.).

M! creates a new scale and renames is Top 8’ 
conical. The new scale is linked to the main 
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scale and both are grouped in a new group 8’ 
conical.

Free placement of 
names

The more names you have on the graph, the 
higher the possibility that they may overlap 
since these are automatically placed by next 
to the end of the scale by the program. You 
can override this command by dragging the 
name to a different position on the graph, ei-
ther vertically in the margin or anywhere on 
the grid. 

To revert to automatic positioning, simply 
check the option Automatic name position 
in the stop’s settings window (section Name, 
Graphic & Compass).
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Chapter 7Analysis of given pipes • Fading out of 
unwanted half tones

With M! you can also analyze given pipes. 
First, open the stop as usual, then enter the 
available data directly into the spreadsheet. 
The graph will show the resulting curve.

Entering a Ø scale in 
the spreadsheet

Open a new document. Rename the stop Untitled 
to Superoctave 2‘. 

Set a foot tone length of 2’:

In the stop’s settings window, click in section Foot 
Tone Level on the Set button and select 2’ from the 
Octaves section.

Since only the »Cs« were measured, only 
these notes will be needed for the bottom 5 
octaves. The others can be faded out for easier 
reading. 

Click on the notes C1, c13, c25, c37, and c49 in 
the Tones column to mark these tones. 

Possible mistakes can be corrected by click-
ing again. 

Select Only marked from the column menu of the 
Tones column. 

All unmarked tones will be faded out.

For the purpose here, one decimal place is suffi-
cient, so choose 1 from the Decimal places sub-
menu in the column menu of Superoctave 2’.

Hiding half tones
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The spreadsheet should resemble this:

Now double-click on the value 55.0 to be able to 
edit it. Enter 62.4 and hit the return key (↩). 

Do the same for the remaining half tones (val-
ues see left).

In the graphic view, activate the unnecessary coor-
dinate at c61 and delete it with backspace (←). 

Create an additional column for the stop Su-
peroctave 2‘ in the spreadsheet:

Hold down the ⌥ key and choose Add Circumfer-
ence Column from the column menu of the avail-
able column. 

	 c13	 =	 37.2 mm
	 c25	 =	 28.0 mm
	 c37	 =	 18.1 mm
	 c49	 =	 12.0 mm
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	 C1	 =	 38.5 mm
	 c13	 =	 24.0 mm
	 c25	 =	 18.0 mm
	 c37	 =	 11.2 mm
	 c49	 =	 7.1 mm

Entering numerical 
values for mouth 
scale

Because the mouth scale of the measured stop 
were not a constant 1:4, we should generate a 
free-variable scale commensurate with these 
values. 

Open the settings window for Superoctave 2‘ and 
select the option Variable in section Mouth Width. 

M! automatically creates a new scale for 
the mouth width: MW Superoctave 2‘, links 
it with the main scale and groups both in a 
new group Superoctave 2‘. In the spreadsheet 
a new column Superoctave 2’ MW (from MW 
Superoctave 2’ [mm] is automatically added.

Now you can enter the available data into the 
spreadsheet:

Double-click on the first row of column  Superoc-
tave 2’ MW (from MW Superoctave 2’) [mm]. Enter 
the measured values (see on the right).



68 Chapter 7

The graph should now look like this:

Create now a new column to analyze the 
mouth width ratio of this stop:

Hold down the ⌥ key and choose Add Ratio Col-
umn from the column menu of the last column in the 
spreadsheet. 

Entering numerical 
values for upper Ø

As a last step, we will generate a free- variable 
upper scale for this stop, since it is conical.
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Open the settings window for the stop Superoc-
tave 2‘ and select the option Conical (var.) in section 
Type & Body. 

As before, when you added the free-vari-
able mouth width, M! automatically creates 
a new scale for the variable upper scale (Top 
Superctave 2’), links it to the base scale and 
groups both in a new group. In the spread-
sheet, a new column for the top scale is added 
(Superoktave 2’ Ø [mm]-Top).

Since the top scale was measured as circum-
ference values (and not diameter), change the 
category to Circumference [mm]:

Choose Circumference [mm] from the column menu 
of the last column.

The option Top scale (End) is retained, thus 
the title of the column should be now Super-
octave 2‘ C [mm] - Top.

Enter the measured values in this column:

	 C1	 =	 95.8 mm
	 c13	 =	 67.9 mm
	 c25	 =	 59.1 mm
	 c37	 =	 42.1 mm
	 c49	 =	 33.0 mm

This concludes the data entry for Superoctave 
2’.

The document window should now look like 
this:

Since there already existed 
a group for Superoctave 2‘, 
M! created a nested group 
when automatically group-
ing the new upper scale 
with the base scale. To clean 
things up, you might want to 
group all three scales (base, 
mouth width and upper 
scale) together into only one 
group:

Drag Superoctave 2‘ onto the 
name of the outer group (also   
Superoctave 2‘). This moves the 
stop from the nested, inner group 
to the outer group. Repeat this 
process for Top Superoctave 2‘.

The outer group now con-
tains all three scales as well 
as the empty, inner group.

Select the empty, inner group 
(Superoktav 2‘) and click on the 
– button below the stop list.

This gets rid of the empty 
group.

Finally, drag the base scale Su-
peroctave 2‘ to the top of the 
group’s contents.
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Registering Wooden 
Stops

For registering wooden stops one usually 
takes the pipe width (=mouth width) and the 
pipe depth.

If the inside dimensions have been taken, the 
values can be directly entered into the corre-
sponding indication type. To do so you set a 
stop of the corresponding foot tone level. 

Open a new document. Rename the Untitled stop 
to Wooden. 

Add two columns for pipe depth and mouth 
with to the spreadsheet. 

Hold down the ⌥ key and choose Add Pipe Depth 
Column from the column menu of the first column. 
Then repeat the procedure and choose Add Mouth 
Width Column.

The mouth width column initially displays 
a 1:4 ratio (the default value for new stops) 
in the column header. As soon as you enter a 
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first value into this column, M! automatical-
ly switches the stop to a free-variable mouth 
width and creates and links the necessary ex-
tra scale.

Enter 125 as the value at C1 in the column Pipe 
Depth.

You can the enter the rest of the measured val-
ues. The values for the width of the pipe (i.e. 
the mouth width) can be entered in the Mouth 
Width column.

If the pipe depth was taken from the outside, 
enter the thickness of the material into yet an-
other column of the stop which you have set 
to Thickness beforehand.

Hold down the ⌥ key and choose Add Thickness 
Column from the column menu of the last column. . 

Enter the measured thickness of the material 
into this column. 

Select the option Out in the column menu of the 
column Pipe Depth.

You may now enter the measured outer depth 
values directly into this column.

When you attempt to enter a value or state-
ment that M! cannot manage, i.e. a deviation 

Error / Bad value
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of more than ±20 HT or mathematical contra-
diction, e.g. division by zero, you contract an 
error.

If you want to lock columns, so the settings 
and values cannot be changed by accident, 
choose the option Lock from the column menu 
of the respective column.

Locking columns



73Chapter 8

Chapter 8Printing • Clipboard • Export & Import 
• Data compatibility with other operat-
ing systems

PrintingBoth the graph and the spreadsheet of a docu-
ment can be printed at any time. 

To start printing, choose the Print command 
from the File menu. 

A dialog appears, where you can choose to ei-
ther print the spreadsheet or the graphic view.

After choosing a view to print, the standard 
print dialog from Mac OS X appears.

If the spreadsheet is printed, the standard print 
dialog contains a section M! in which you can 
control if you want to print all or only selected 
columns (i.e. columns with at least one select-
ed value). You can also change the font size, 
line spacing and the left margin in this sec-
tion. To return to the default settings, click on 
the button Reset to Defaults.

You can skip this dialog by 
holding down the ⌥ key or 
the ctrl key while choosing 
Print from the File menu.

When holding the ⌥ key, 
the spreadsheet is printed. 
Holding the ctrl key results 
in printing the graphic view. 
The standard print dialog 
from Mac OS X will be dis-
played anyway.

ClipboardWhen you copy values or columns from the 
spreadsheet with Copy (Edit menu), these are 
formatted onto the clipboard. You can paste 
the copied data in a different place on the 
spreadsheet or, into a different program (such 
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Export as CSV The menu command Export (File menu) 
works on the same principle as above, except 
that the data is not copied to the clipboard but 
to a file. The generated file can be read by any 
application that can read CSV files. 

Export orientation

Excel, Numbers, Pages or Word). M! copies 
not only the data itself but also the column 
headers and note names. 

You can specify whether the copy is to be 
horizontal or vertical. You’ll find a setting for 
this in the application’s preferences in the tab 
Print & Export (see »Application preferenc-
es« at page 79).

In horizontal mode, the columns are printed 
as lines:

	 C1	 c13	 c25	 c37	 c49	
Octav 4‘ Ø [mm]	 92.46	 54.98	 32.69	 19.44	 11.56

In vertical mode, the columns as such remain 
unchanged:

	 Octav 4‘	
	 Ø [mm]	
C1	 92.46	
c13	 54.98	
c25	 32.69	
c37	 19.44	
c49	 11.56	

Tabs are inserted between the individual col-
umns by default. The separator character can 
be configured (see »Application preferences« 
at page 79).
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Export as DXFM! supports export of diameter data in 2D 
DXF files. The diameters are exported as cir-
cles (incl. center points) and thus can be im-
ported in many CAD applications.

When exporting, choose Export Diameters as 
DXF file in the standard file dialog. As before, 
you might want to also select the option Ex-
port only selected values, which limits the ex-
port to either the selected stops in the stop list 
or selected values in the spreadsheet (which-
ever results in fewer circles). Please note, 
that only spreadsheet selections in diame-
ter columns are considered!

When exporting multiple stops, the exported 
data is written in a folder on disk. The name 
of this folder is what you enter in the file di-
alog. The diameter data of the exported stops 
is written into separate files into that folder 
(one file per stop, the files are named after the 
stops). If only one stop is exported, the name 
of the exported DXF file is entered in the file 
dialog. No folder is created in this case.

The DXF data is written in 
R27 (2013) format.

After choosing Export, a standard file dialog 
appears. Choose a destination and file name 
and select the option Export Data as CSV File. 
Optionally, you might want to select Export 
only selected values. If this option is selected, 
M! exports only values which are selected in 
the spreadsheet.

The settings for export orientation and separa-
tor character work the same way as with copy-
ing data to the clipboard (see above).
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By default, the exported diameters are inner 
diameters, i.e. without thickness of the ma-
terial. In case the thickness values are avail-
able in the spreadsheet, it’s also possible to 
export outer diameters by selecting the values 
in a column with the category Ø [mm] and the 
option Out selected (i.e. a column displaying 
outer diameters). Select all values in a column 
by clicking on the header of the column and 
then select the option Export only selected 
values in the export file dialog.

To import (Import in File menu) data, the data 
must have a particular format: 

Columns must be separated by tabs (AS-
CII:9), lines by »carriage returns« (CR, AS-
CII:13). Besides the actual values, the names 
of the stops can be inserted

First, open the desired stops in M! and be sure 
that the foot tone levels are correct. Arrange 
the spreadsheet so that the columns are in the 
same order as in the import file. It is possible 
to define fewer columns than in the file, but 
the trans- fer will be stopped at that point. Be 
sure that the categories in the columns are set 
correctly according to the import data. After 
choosing Import from the File menu and se-
lecting the import file, you can select multiple 
options:

When you select the option Read Stop Names 
from First Line, M! interprets the values of the 
first line in the import file as stop names.

Import
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The value at Value start at column controls 
from which column the import will be started.

If a cell is selected in the spreadsheet, you 
might want to select Start Importing at Se-
lected Cell. If selected, the imported data is 
written to the spreadsheet, starting at the se-
lected cell.

Drag & DropStops can be copied between documents by 
drag & drop. Just drag the name of a stop or 
group from the stop list of one document to 
the stop list of another document. The dragged 
items are copied to the second document.

Data exchange with 
other operating 
systems

All files, saved from M! (not only exported 
data) can be exchanged between different 
operating systems: Macintosh, iOS and Win-
dows. 

The file name of document files for M! should 
contain the file extension .mensur in order to 
get recognized and assigned correctly with 
M!.

It’s also possible to exchange 
tuning files (for calculating 
pipe lengths). The correct 
file extension for these files 
is .msti.
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Chapter 9Preferences in M! • Program prefer-
ences • Document preferences

Open the application’s preferences by choos-
ing the Preferences command from the M! 
menu.

Application 
preferences

There are two different types of preferences 
in M!. 

The application preferences contain settings 
valid for the application in general, like print-
ing preferences, as well as settings which are 
used when creating new documents (e.g. com-
pass).

Documents have their own preference win-
dow to control settings only valid for the re-
spective document (e.g. compass and tuning).
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The preferences window is divided in 4 tabs: 
Presets, Print & Export, License and Update.

The tab Presets contains settings for new doc-
uments, stops and columns. In the section New 
Documents you can set the desired pitch and 
temperature. This is the default pitch and will 
be used for calculating pipe lengths. You can 
also set a default compass for new documents 
there. If you need to change these settings for 
an existing document, you want to make these 
changes in the document’s settings (see »Doc-
ument preferences« at page 81). 

The preferences in section New Stops & Col-
umns set the default number of decimal places 
in new columns and if new stops should be 
created with the graph in Bézier mode or free-
hand mode (see »Modifying scale curves« at 
page 19).

The tab Print & Export contains the section 
Printing in which you can set the default font 
size and line spacing for printing spread-
sheets. These default values can always be 
overwritten in the standard print dialog (see 
»Printing« at page 73). The section Export 
let you control the Export Orientation and 
Field Separator. These settings are valid for 
both, Copy & Paste and Export to disk (see 
»Export orientation« at page 74).
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M! supports automatic checking for updates. 
This feature requires an active Internet con-
nection. M! asks during the second launch if it 
should automatically check for updates in the 
future. You can change that setting anytime in 
the tab Update and also refine some settings, 
like the time interval M! checks for updates.

Click on the Check Now button to check for 
updates manually. There’s also a menu com-
mand Check for Updates… in the M! menu.

Document 
preferences

If you want to change preferences only for an 
existing document, open the document’s pref-
erences window by clicking on the Document 
Settings button below the stop list.

The tab License is used for displaying and en-
tering your application license information.

If you already own a license code for M! you 
can enter the licensed name and the license 
code here. Click on the Check License but-
ton after entering your credentials to unlock 
M! (also see »Entering license data« at page 
10).

If you’re using the demo version of M! and 
not yet own a license code, you can click on 
the Buy license button to purchase a license 
online.
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In the section Temperament, you can set 
the pitch desired for 12tet to calculate pipe 
lengths. If you wish a different temperament, 
click Change to open another window into 
which you can enter cent deviation for each 
halftone of the scale by activating the indi-
vidual edit fields. Its possible to export and 
import specific temperaments. The exported 
temperament files can be exchanged between 
different computers and operating systems. 
The default file extension for temperament 
files is .msti.

The section Compass allows you to set the 
compass for all stops in the document. 

In the Progression section you can define the 
normal scale based on which are all calcula-
tions and displays. Default setting is the so-
called Töpfer Normal Scale (halving on the 
17th).
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Index
Symbols
12tet  26, 82

A
Addition constant  43
All Half Tones (Menu command)  16
Analysis of given pipes  65
Anchor points  19
Application preferences  79
Arithmetic operations  57
Automatic Name Positioning  34

B
Bad value  71
Base tone  37
Bézier curves  19
Bézier mode  80
Broken scales  42
Buy license  81

C
CAD applications  75
Checking for updates  81
Chimney Flute  26, 35
Circumference [mm] (Menu command)  

25
Clipboard  73

Export orientation  74
Columns  25

Change width  15
Changing category  13
Changing the type of values  13
Deleting columns  41
Duplicating columns  14

Fixing Links  30
Free columns  28
Locking columns  72
Moving columns  15

Comments  54
Change  54
Delete  54
Linking comments  55
Move  54

Compass  34, 82
Connection Point  21
Constant progressions  39
Copy (Menu command)  49, 73
Corner point  21
Covered pipes  26
Curve point  21
Cut list  30
Cut-Up (Menu command)  27

D
Data exchange  77
Decimal places (Menu command)  15, 28
Deleting columns  41
Deviation [HT] (Menu command)  25
Diameter [mm] (Menu command)  25
Documents

Compass  82
Document preferences  81
Duplicating a document  16
New  48
Opening documents  17
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Progression  82
Renaming a document  16
Saving a document  16
Temperament  82

Document Settings  81
Drag & Drop  77
Duplicate (Menu command)  16
Duplicate this column (Menu command)  

14
Duplicating scales  49

E
Eraser Tool (Menu command)  22
Export

as CSV  74
as DXF  75

Export (Menu command)  74
Export only selected  76
Export orientation  74, 80

F
Factor… (Menu command)  28
Field Separator  80
File extension  77
Fill Up/Down (Menu command)  30
Filter displayed half tones  15
Fixed-variable scales  43
Fixing Links  30
Foot tone level  34
Formulas  29

Fixing Links  30
Links in Formulas  29

Free Columns  28
Free-hand mode  19, 23, 80
Free Ø  37
Full screen mode  12

G
Graphic pad  23
Graphic view  11
Grid  18
Grouping scales  56

H
Half Plate Width  [mm] (Menu com-

mand)  25
Hiding half tones  65

I
Import (Menu command)  76

L
Launching M!  10
Left margin  73
License  10, 81
Line spacing  73
Line type  34
Linking mouth scales  50
Links in Formulas  29
Locking columns  72
Lock (Menu command)  28
lth  25
lth-EC [mm] (Menu command)  26

M
Macros  57
Main window  11
Mouth Scales  36

Automatic scale for mouth width  52
Constant ratios  47
Free-variable mouth scales  47
Numerical values for mouth scale  67

Mouth Width [mm] (Menu command)  25

Documents (cont.)
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N
Non-cylindrical pipes  61
Normal Scale NM  13
Numerical values for upper Ø  68

O
Only C-F# (Menu command)  16
Only marked (Menu command)  16
Open… (Menu command)  17
Open pipes  26
Out (Menu command)  31

P
Paste (Menu command)  49
Pen Tool  (Menu command)  20
Pipe Depth [mm] (Menu command)  25
Pipe width  70
Pitch  25
Plate width  25
Pointer Tool (Menu command)  20
Position panel  18
Preferences  79
Presets  80
Printing  73, 80

Left margin  73
Line spacing  73

Print (Menu command)  73
Progression  40, 82

R
Ratio [1:n] (Menu command)  25
Refer Graphical Representation to NM  

38
Remove this Column (Menu command)  

51
Rename... (Menu command)  16

Renaming a group  56
Revert to  (Menu command)  23
Rohrflute  26

S
Save (Menu command)  16
Scales

Broken scales  42
Duplicating scales  49
Fixed-variable scales  43
Free placement of names  64
Grouping scales  56
Line type  34
Link  62
Linking mouth scales  50
Modifying scale curves  19
Moving a scale  17
Numerical values for upper Ø  68
Select & Deselect a scale  17
Standard scale  44

Show Number & Graphics View (Menu 
command)  17

Snap to Vertical Grid (Menu command)  
18

Spline mode  19
Spreadsheet  11
Standard scale  44
Stop list  11
Stops

Broken scales  42
Changing color  34
Compass  34
Covered stops  35
Creating a new stop  33
Fixed-variable scales  43
Foot tone level  34
Free placement of names  64
Grouping  56
Line type  34
Mouth scales  36
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Rename stops  12
Renaming  34
Standard scale  44
Stop preferences  33
Visibility  41
Wooden stops  70

Stylus  23

T
Temperament  82
Temperature  25
Temporary changing of tools  22
Theoretical Length [mm] (Menu com-

mand)  25

Stops (cont.)
Thickness [mm] (Menu command)  28
Töpfer Normal Scale (NM)  13, 39, 82
Top Scale (End) (Menu command)  28, 

61
Type & Body  61

U
Undo (Menu command)  23
Updates  81

W
Wind pressure  26
Wooden Stops  70
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